LA (elg\7S R a¥l8] Guide to Calm Cataloguing and Export to the Archives

https://archiveshub.jisc.ac.uk H u b

This guide will assist you with ensuring your CALM catalogue data is appropriate for contributing to
the Archives Hub.

The guidance relates to creating consistent descriptions, but it is primarily focused on cataloguing for
the export of EAD, which can be used for the Archives Hub or for other purposes.
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Setting up your Calm templates

Make sure your record templates are set up correctly in your CALM database. This is to ensure you
have all the fields that are needed for the Archives Hub present in your cataloguing interface. You
will need to check the templates for:

Collection Records (Fonds/Collection level)

Component Records (Anything below Fonds/Collection level)

Other record types — see below under 'Other Record Types' for Object and Photograph

e Open the Admin program

e Go to <File>
e Select <Open>

e 'Open Database' dialogue box will display - select 'Catalog' then press OK (this can only be
opened if the CALM database isn't already in use)

e Go to <Record>

e Select <Modify Types>

¢ 'Modify Record Types' box dialogue box will display

Modify Record Types @
Record Type: Fields in Record: Fields:
Article AltRefNo ACCESS \
Association Author AccessCategory
Biography Title E << Insert AccessCategoryDate
Book =| |RCN AccessCategoryNote
Collection ISBN i << Append AccessConditions
Component RefNo AccessionDate
Cont.ent Source . AccessionNumber
Email Class Accruals
Object Type Accumulation
ObjectCollection ~ |Publisher % AccumulationDates %
Add... OK | Cancel Help

e Select 'Collection' from the left-hand Record Type column.

e Look through the middle 'Fields in Record' column and identify any missing mandatory or
recommended fields (see tables on pages 4-9)

e Click on any missing fields in the right 'Fields' column and press insert to include them in the

record type.

e To do the same for lower-level records choose Component then follow the same steps.

Calm Record Types

Calm has a whole range of record types in addition to Collection and Component — Article,
Biography, Email, Book, etc. Each of these is associated with a range of fields in addition to the fields
normally used for Collection and Component. We have now modified our template to work with
some key fields associated with Book, Object and Photograph. Our template does not work with

other record types.
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We will not export all fields associated with these types, but we have included Object Name,
Dimensions, Process Name, Method and Note, Colour and Material. For books, we have included the
key fields within the title, as a citation entry. This includes Author, Title, Publisher, Date, Edition.
Book records can only appear at lower levels.

Other suggestions for setting up the template:

Pre-populate certain fields with default content (e.g. country code, repository name, repository code
e Go to <Field> then select <Default Content>

Pre-populate certain fields with a picklist of default content (e.g. level, language, access conditions)
e Go to <Field> then select <Pick List>

Set up certain fields as unique, to prevent duplicates. This can be done for any field, but it is
particularly useful for refno and altrefno

e Go to <Field> then select <Properties>
e Select the required field and click it as 'unique'

NB. all of the above changes to record types will affect new records created but will not
retrospectively change content of already existing records. To bulk insert fields (with or without
default content) to already existing records, Axiell can provide a script.

Hide Fields
Note that showing or hiding individual fields within Calm does not affect the EAD export. It is the
export template that specifies which fields display and which are hidden.

If you have sensitive information that should not be displayed, we need to discuss a modification to
the template to hide the field's contents.

Draft Catalogue Display

Note that if you have a catalogue status of 'draft' the entry will publish on the Hub by default.
However, we can make a switch to ensure that all 'draft' entries (and children of those entries) do
not display. Please let us know if you want this switch to be made.

Closed Access Display

Note that if you have an access status of 'closed' the entry will publish on the Hub by default.
However, we can make a switch to ensure that all 'closed' entries (and children of those entries) do
not display. Please let us know if you want this switch to be made. We can also make this change for
'draft' entries.

Completing a collection level record
The table below outlines the mandatory fields for a collection level record. These should be used as
the minimum basis for cataloguing.

Default content - it has been noted where fields could be bulk inserted or set up in a template with
default recurring content.
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Picklist fields - it has been noted where a picklist might exist, or it might be useful to create one. These
will either have a drop-down menu (which can't be edited) or a pop-up menu (which can be edited or
free text can be typed)
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Archives Hub Mandatory Fields in Calm

(Ref_No,
Alt_Ref_No,
Findingno)

description.
Used to create a unique URI on
the Archives Hub

Calm Field EAD tag Purpose Example Notes on format
Country code <unitid> To identify uniquely the unit of | GB - Should be in accordance with the latest version of ISO
(country_code) description. (currently 3166-1)
Used to create a unique URI on - Should be uppercase
the Archives Hub - Will most likely be GB
- Press F9 to display within CALM
*BULK INSERT
Repository code <unitid> To uniquely identify the unit of | 219 - Usually the Archon code for your organisation (or the
(repository_code) description. organisation that holds the material if that's different)
Used to create a unique URI on - Must exclude any leading zeros e.g. 0219 would be
the Archives Hub 219
- Press F9 to display within CALM
*BULK INSERT
Reference number <unitid> To identify uniquely the unit of | WWE Calm Reference

- Every entry at every level MUST HAVE A UNIQUE
REFERENCE

- In the CALM reference a slash (/) is used to denote a
change of hierarchical level so it is important not to
change the automatically generated reference

- The reference must not end with a trailing slash

- The reference should not be longer than 500
characters

- Use the Calm tree to check references

- Set up options in Calm tree to identify duplicates (Click
on <tree>, then <refno> to open up tree, right click and
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choose options. Tick box to 'Warn if duplicate items
found')

AltRefNo or Findingno

- You may wish to use AltRefNo or FindingNo as your
reference number.

- Add a unique AltRefNo at every level

- Remember that the Calm automatically generated
reference must be kept, as it generates the hierarchy
through the numbers of slashes (/).

- Make sure the Archives Hub are aware you are using
the AltRef as your reference

Calm Ref Example:

ABC (parent level)

ABC/1 (first child level)
ABC/1/1 (second child level)
ABC/1/1/1 (third child level)

AltRef Example:
ABC

ABC-A

ABC-A/1
ABC-A/1(i)

NB: You can display both Calm and AltRef on the
Archives Hub if you wish to. AltRef can also be labelled
as 'former reference' if this is required.
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Title <unittitle> To name the unit of description | Vale of Glamorgan - Should be a formal or supplied title for the unit of
District Council description
Records - Should be meaningful so that it works as a stand-alone
title (not one word or just the name of creator)
Peter Brook - Ideally not more than 500 characters
Collection Dates of the material should go into the separate Date
field
Records of Tennent - At collection level, should normally consist of:
Caledonian Brewers, e Personal/family/corporate name of collection
Glasgow, Scotland creator
e Collection type, e.g. Records, Papers, Collection
e May also include profession/geographical
location etc. as appropriate
Dates <unitdate> To identify and record the 1889-1912 - Calm allows for d m yyyy. We recommend dd month

date(s) of the unit of description

yyyy as more user-friendly and consistent for display

- Calm adds a 'normalised' year date range for export.
The Archives Hub uses your input date for display and
the normalised date for date searching

- Make sure you adhere to the Calm format for dates, so
that the normalised date is created correctly

- Multiple date fields can be used if required

- c or circa can be used (not ca). It creates a margin of
10 years in the normalised date, e.g. ¢ 1910-c 1912
normalised date is "1900-1922"

- NB An open date (1850-) will generate a normalised
date of "1850-1850". '1850-ongoing' generates an
empty normalised date. We would have to rectify this in
the Archives Hub data processing.
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EXAMPLES:

1901-1974 (normalised: "1901-1974")

28 Jun 1884 (normalised: "1884-1884")

Early 18" century (normalised: "1700-1739")
No space between hyphens and numbers,

e.g. 28-29 July 1884 (normalised: "1884-1884")
[3 March 1901] (normalised: "1901-1901")

¢ 10 April 1889 (normalised:"1879-1899")

¢ 1900-1910 (normalised: "1890-1920")

*PICKLIST MENU

Level <archdesc level> To identify the level of Fonds -Fonds or collection are typically used at the top level,
arrangement of the unit of but you can catalogue at series level if you wish.
description .

P Calm has a controlled list of values. We recommend
using the standard values of
fonds/collection/series/subseries/section/subsection/pi
ece. These will translate into EAD level values.
*PICKLIST MENU

Extent <extent> To identify and describe the 30 boxes - Record unit and measurement (e.g. box, file, volume,
physical or logical extent 10 volumes paper)

3 cubic metres

- If you want to give two equivalent sizes, we
recommend using brackets,

e.g. 10 boxes (2 cubic metres)

- If you want to list separate sizes, we recommend using
two 'extent’ fields
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Repository name

<repository>

To identify the institution or
agency responsible for providing
intellectual access to the
materials being described

West Glamorgan
Archive Service

V&A Theatre and
Performance Archive

- Name of the repository should always be consistent
- Should only contain the repository name, not the
archon code or address information

- This field must contain your repository name and not
just 'Archive'

*BULK INSERT or PICKLIST MENU
(if multiple institutions)

Scope and content
(description)

<scopecontent>

To enable users to judge the
potential relevance of the unit
of description.

The collection
consists of records of
the Guest Keen
Nettlefold group and
predecessor
companies,
Glamorgan Hematite
Iron Ore Mine
Company and Cardiff
Hematite Iron Ore
Company. The
records relate largely
to Glamorgan
Hematite Iron Ore
Mine, Llanharry, but
also include material
from other significant

- Give a brief summary of the scope (such as, time
periods, geography) and content (such as documentary
forms, subject matter, administrative processes) of the
unit of description

-Add names, subjects and places that you will include as
index terms.

10 Nov 2023 (v.6.1)




iron and steel works
in south Wales

Access conditions

<accessrestrict>

To provide information on the
legal status or other regulations
that restrict or affect access to
the unit of description

This collection is
open for research. It
is advisable to book
in advance, for
details and opening
hours see
http://archives.denbi
ghshire.gov.uk/visit-

us/. Access to some
documents may be
restricted due to
Data Protection
legislation,
Denbighshire Record
Office will advise
where this is the case

- Standard text can be included in a picklist e.g. 'Some
records are subject to access restrictions under the
Data Protection Act'

-This field is mandatory for the Archives Hub at the top
level because it is vital researchers know whether they
can access the materials.

*PICKLIST

Language

<language>

To identify the language(s), used
in the material being described

Welsh
English
French

- If the material is in more than one language, they
should be recorded in separate language fields
commencing with the predominant language(s)

(To add fields go to <field>, select <insert>, then choose
‘Language')

- The Archives Hub will add the ISO code for the
language, e.g. French (fre)
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Other fields for collection level descriptions

Field

Tag

Purpose

Example

Notes on format

Creatorname

<origination>

To identify the creator (or
creators) of the unit of
description

Berry, Ronald Anthony [Ron]
(1920-1997)

- Typically, the creator is only included at the
collection level; it could be included at lower
levels if it is a different person/organisation,
e.g. a series of letters written by a
correspondent of the archive creator

- If there are multiple creators, they should be
recorded in separate fields (go to field, insert,
creatorname)

- The Archives Hub can take creator names
from either the 'creator’ field or the
'origination’ field

- The name should, where possible, be given
in the standardised form as prescribed by
national conventions e.g. NCA rules. Standard
format would be surname, forename, dates.

Epithet can also be included.

Admin history

<bioghist>

To provide an administrative
history of, or biographical details
on, the creator (or creators) of
the unit of description to place
the material in context and make
it better understood

On 10 Feb 1914 The South Wales
Transport Company was
incorporated as a subsidiary of the
British Electric Traction Company
Limited (BET). It was formed to
operate bus services in Swansea
and surrounding towns (Neath,
Llanelli, Pontardawe etc)....
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Digital Archival <dao> Images, which will be displayed | URL: If the URL has a public link to an image,
Objects on the Hub, and can include a https://archiveshub.jisc.ac.uk/imag then the Hub will pick up the image and
short description. Use the URL es/content/features- display it. It will create a thumbnail and
field. artshumanities-boswell-lg.jpg link to the full size image. The optional
Note that export template description will be displayed.
Nov2019 corrected a problem
with the URL Description. You You cannot enter more than one URL for
must have the URL Description each level.
field displayed or you will get an
export error, but you can use it or
leave it empty.
Format <genreform> Format or genre of the material | Manuscripts, Typescripts, VHS If you add all your formats in one format
tapes, 35mm film box, this will create one single link on the
Hub. It is best to split your formats, one to
each box, and then they become separate
links on the Hub.
Notes <notes> For content that does not clearly It can be useful to have a place to put
fit into any other fields. information that does not appropriately
fit in any other field.
Subjects/Terms <controlaccess> The subject and terms databases | Manufacturing Adding subjects helps to make your

<subject>

can both be used — the content
exports to the 'subjects’ field in the
EAD.

NB: The subjects database is a
single hierarchy thesaurus; the
terms database is a
polyhierarchical thesaurus. Note

description more discoverable. It also
clearly represents what your archive is
significantly about.

- It is best to use a recognized thesaurus
or set of indexing rule, such as the
UNESCO Thesaurus
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that we only ingest the term as it
appears in your Calm record.

Authorities /
Related_Name_Code
(index terms)

<controlaccess>
<persname>
<corpname>

To provide structured metadata
for the significant people and
organisations represented in the
records.

Create names in the Calm
persons/institutions database
and link to them from within
your Calm description. This will
include a 'DS' reference in the
Related Name Code, and the Hub
export will be able to access the
name.

Raymond Henry Williams (31
August 1921 — 26 January 1988),
academic, novelist and critic

Access points or index terms are not
mandatory, but they are highly
recommended.

- Include an access point for the name of
the person(s) or organisation(s) who
created the collection

- Always try to include life dates, or floruit
dates if life dates are not known

- Include other significant names

- Access terms at collection level apply to
all levels; those at lower levels are specific
to those levels
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Creating a component level description
Provide more detailed descriptions of the Sections, Series, Items etc within the collection using the
component level template.

® You can create a new Component record in several ways-

1. With a Collection level record open, select <Record> from the left hand side menu then
<Add Below>

2. From CALM's main menu, select <Archive Menu>, Select <Catalogue Menu>, Select
<New> and then choose record type '‘Component'

Within the Component template you can choose to enter data at different levels, for example: series,
sub-series, file, item etc

Lower levels are considered to be “children” with the next higher level being the “parent”.
e You can add 'child' component records at any level in several ways;

1. Select <Record> from the left hand side menu then <Add Below>

2. Click on <Tree> then <Ref_No> to open up the collection tree. Click on an entry in the tree
with the right mouse button to bring up option to 'Create Child'

Records added at the same level are called “sibling” records i.e. a number of Series level descriptions
would be “siblings” of each other.

e You can add 'sibling' component records in several ways;

1. Select <Record> from the left-hand side menu then <Copy >. This prompts you to give the
record a unique reference number and just carries over the data in the Level, Repository,
RefNo, and Title fields.

2. Select <Record> from the left-hand side menu then <Clone>. This copies over all of the data
within that record, except RefNo.
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Archives Hub mandatory fields at component level in Calm

Field EAD tag Purpose Example Notes (see mainly notes above)
Country code <unitid> To identify uniquely the unit of GB
(country_code) description.

Used to create a unique URI on the
Archives Hub

Repository code <unitid> To identify uniquely the unit of 219
(repository_code) description.

Used to create a unique URI on the
Archives Hub

Reference number <unitid> To identify uniquely the unit of WWE/1 - Every entry at every level MUST HAVE A
(Ref_No, description. WWE/1/1 UNIQUE REFERENCE

Alt_Ref No, Used to create a unique URI on the WWE/1/1/1 - In the CALM reference a slash (/) is used
Findingno) Archives Hub to denote a change of hierarchical level

and generate the tree structure, so it is
important not to change the
automatically generated reference

Title <unittitle> To name the unit of description Stanley Royal - Make a lower level title as meaningful
Hospital Minute as possible as a stand-alone description
Book - It is recommended to add dates in the
Drawings and separate Date field, especially for series

research material on | of materials such as minute and account
clocks books

NB In general, do not repeat information at lower-levels, but provide relevant information for the particular subfonds, series or item being described.
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Further Tips for Cataloguing

Where you want to add two separate pieces of information in one field, always generate a
new box, e.g. two creators, two languages

Customised fields within Calm cannot be exported, as they do not conform to the export
template. Be aware that these fields will not be included in the Archives Hub

Every level of description should directly describe the materials you are cataloguing. Do not
use levels simply to wrap a title around a section.

Make sure a URL for an image is persistent. Note that the Archives Hub will copy the image
and use the copy for display, so that it will remain available from within the Hub. But if the
URL is broken then it will not be available from elsewhere, e.g. Archives Portal Europe

Exporting from CALM

HwnN e

o v

Cataiog| Loans|
dl| - Catalog 1stof 2

Search for the collection you want to export on CALM

You may want to double check against quick CALM export checklist (see Appendix 1)

Go to <File>

Select <Report> then select the latest Hub EAD template. Check the Calm webpage for the
latest version of the export: https://archiveshub.jisc.ac.uk/calm.

Save the .xml file in an appropriate location
The export should complete without errors

IDENTITY

‘Title [ABX Archive
te [1350-1930

Select File > Report to bring up the list of export options. Select the appropriate Archives Hub export

template.

Country Code: if an error is reported, e.g. missing countrycode, but you know that it's present at

collection level, make sure you're starting the export whilst the collection level record is open.
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Repository Code: The repository code must be present, but Calm does not raise an error if it is not.
You need to be aware of this and ensure it’s included, otherwise an error will occur when we try to
ingest your descriptions, and we will need to ask you to correct and re-send them.

Troubleshooting

Error message: “Failed to parse report template ead/archiveshub/hubead2002-CLD-22Mar2017.xml.
Field ‘RelatedNameCode’ is not defined for this record type.”
Solution: RelatedNameCode is a value in our template. but for version 9.1 (and possibly other older

versions), this value needs to be PersonCode. Contact the Archives Hub, who can provide you with
this modification.

Error message: ‘Failed to open joined database Persons. Cannot open exclusively.’
Solution: This is a known bug that Axiell are aware of. Axiell have recommended to us that Calm

users upgrade to version 11 to fix this. Unfortunately, this is an error within the Calm system and
there is nothing the Archives Hub team can do to fix it.

Image not displaying: Check the URL is correct — it should end .jpg or .gif or similar, and if you enter
it in a browser it should only display an image, and not a page that contains an image embedded into
it. Check you have not entered more than one image (i.e. two URL fields both with images), and
check if you have two URL fields and have only used the second one (you must use the first one).

Error due to lack of a 'URL description': Templates before Nov2019 output the URL Description as
invalid if it is empty.

Solution: The Nov2019 template corrected this — it can still be empty, but it is valid EAD (because it
includes paragraph tags).

Exporting Calm XML

If you are getting an error you don’t understand, and can’t export EAD, it may be a good idea to
export native Calm XML and sent that to us. We can then upload it to our own instance of Calm, and
replicate your environment. We may then be able to find a fix.

To export Calm XML, open the description in Calm, and then go to File -> Export, select Hit List,

Method: XML. To file: give it a name and somewhere to save, and then click ok, Calm will export
the description in native DScribe XML format, rather than EAD.
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[ NoX } Remote
o Calm - [Catalog]
[) File Edit View Search Field Record Hit List Help
Import... - I v [ o Lo L v L | v L
::::" | Object_Number Ref_No Object_Name Title
oo 5 :ction BOO Test collection of SA boo|
BOO/1 The Training of Children
Run Script... BOO/3 The General's Letters 18!
e BOO/4 Salvation Soldiery: a seri
: wor BOO/5 Salvation Soldiery: a seri
ABTOrtes™> Item BOO/6 In Darkest England and
—r— Item BOO/7 In Darkest England and t
ltem BOO/8 How to Preach
Issue Loan ' ltem BOO/9a Letters to Salvationists of
BoenmRrT™ ftem BOO/9b Letters to Salvationists of
ltem BOO/9c Letters to Salvationists of
Reporis> ' BOO/0 Test Book
Search Names

Search Places

- Catalog 1st of 12
< Back '| e

Open the description (with all of the level) and go to File > Export

LEMErS 10 Salvatonists on Rengron 1or Every Uay
Letters to Salvationists on Religion for Every Day
Test Book
) Export Records To File X
What Options —
Method: XML v
O Current record Copies: |1
@ Hitlst lobes Collate copies eancel
O All records [Export to Clipboard) Suppress blank lines Help
O Hit list range: Format Append to output file
From 1 : : Joined records
- File... Edt. Character conversion:
To 12 [None)

Make sure the Method is XML and click ‘To file’ to name and confirm the location. Then click OK to
save the file.

<?xml version="1.0" encoding="UTF-8" 7>
k!DOCTYPE DScribeDatabase SYSTEM "boo-test.dtd">
<DScribeDatabase Name="Catalog">
<DScribeRecord>
<RecordType>Collection</RecordType>
<Level>Collection</Level>
<Repository>Salvation Army International Heritage Centre</Repository>
<RefNo>B00</RefNo>
<Extent>10 books</Extent>
<Class></Class>
<Author></Author>
<Editor></Editor>
<Title>Test collection of SA book records</Title>
<Date>2019</Date>
<Description>Test collection of SA book records</Description>
<Type>Collection</Type>

~Serioc~./Sariac

The file will be native Calm XML, with <DScribe> tags.
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Adding the Archives Hub Export Template to your Calm system

In order to export from Calm, you need to use an export template. This is the document that take the
Calm content and transforms it into Hub EAD.

The Archives Hub has worked on the export template over time. If we want to make modifications, e.g.
add a field that wasn't exporting, then the template has to be updated. This means we date the
templates and ask you to add the most recent template. We will let you know when a new template is
published, and what the modifications are. We have the most recent template available from
https://archiveshub.jisc.ac.uk/calm.

The Archives Hub export template needs to be added to the Calm system:

1. Save the export template into the correct folder, alongside the other Hub export templates. This
should be: DScribe > Archive > reports > ead > archiveshub. E.g. if you are working with 'hubead2002-
October2019.xml' then save this into the folder. You may also have other templates listed in this folder,
which is fine.

NB: If you are using a client/server version of CALM (on multiple computers) rather than a standalone
version the template needs to be placed on the server version of this directory. This may be under the
control of your IT Dept, rather than the archive service, so you may need to forward these instructions on
to your IT department.

©
[4 | = | archiveshub - o X
Home Share View (2]
J c /< 7 New item ~ J Ope FH setectan
a M $ ] Easy access ~ Select none
e e 7] P = & pete = W @History T Invert selection
Clipboard Organize New Open Select
« v > ThisPC > Windows (C) » dscribe > Archive > reports > ead > archiveshub v &| | Search archiveshub »
&) Pictures A Name - Date modified Type Size
[ videos [7] hubead2002 13:21 XML Document 20K8
v i Windows (C) [] hubead2002-16)uly2018 76 KB
Adlib [] hubead2002-22Mar2017 76 KB _
v [} dscribe ] hubead2002-Nov2013 76 KB
v Archive | hubeadv1 38KB B
Cmd
db
dtd
Input P
Output
v || reports
eac
S 8]
a2
anw —
archiveshub
standards
Temp v
Templates v 7
pal_>items j' + 100%

10:46
07/01/2019 E‘

L A® 7

Save the export template in the ‘archiveshub' folder

2. Open the document ‘reports.xml’ in the \dscribe\Archive\reports folder in order to edit it. This
document simply lists the templates available to you.
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< | reports - a X

Home Share View 2]
=1 J & cut < ] x -IJ 7 New item ~ J @ open >  Hsetectan
= W= Copy path 1] Easy access ~ t Edit Select none
Copy Past - Move Copy Delete Rename  New Properties .
7] tov tov > folder S @History [ Invert selection
Clipboard Organize New Open Select
« v > ThisPC > Windows (C:) > dscribe > Archive > reports > v & | Search reports »
B Videos A Name | Type i
25 Windows (C:) eac File f
Adlib ead File folder
dscribe [] reports XML Document 3KB .
0
Archive pen L
Edit
Cmd
7-Zip >
db
CRC SHA >
dtd 12 Share
Input Open with >
Output Scan with Sophos Anti-Virus
reports Restore previous versions
¢ Send to >
ead
o D
2
o Copy
anw
Create shortcut
archiveshub E
Delete
standards
Rename
Temp
Propert
Templates RS v
bin v Z
3items 1 item selected 2.16KB [E=

Open the 'reports' document in edit mode

You just need to add an entry for the new template. This must go within the right category:
<category title="Archives Hub” expanded="Y" >

Each template is within a <report> tag. You may have several templates within this <category> area,
which is fine. Just add the new one as a separate <report> entry. It does not matter which order the
templates are listed in.

e.g. for the October2019 template:

<report title="Hub EAD - October 2019" path="ead/archiveshub/hubead-October2019.xml"
ext="xml" direction="B" database="Catalog" />

This means that the ‘October2019’ template will be listed in the pop-up window showing 'Reports' when
you do the export.

The ’report.xrh/ ' document sifﬁp/y lists the reports — each within a <report> set of tags grouped by
<category>

10 Nov 2023 (v.6.1)



When you are then ready to export, you choose File > Report, and you will see the EAD export options for
the Hub. Make sure to choose the right template — the one you have added, which should be the most
recent Archives Hub template.
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Appendix 1: Quick export checklist

Collection level mandatory fields
Country code

Repository code

Reference number

Title

Dates

Level

Extent

Repository

Scope and content

Access conditions

Language

Collection level recommended fields
Creator name

Admin history

Access points (index terms)

Lower level mandatory fields
Reference code

Reference number

Title

Checks for all levels

Multiple languages- split into two fields
Multiple creators- split into two fields
Duplicates —ref no or altrefno

Check tree for any false/missing levels
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Appendix 2: Calm Fields Included in the Export

This list includes all of the fields that we map into an EAD description. At the bottom there is a list
relating to the Calm Book Type. There are also some fields that come from Calm Photograph Type
included.

We can potentially add fields to this list, but we have to implement an export that works for all Calm
users, so we cannot add bespoke fields or fields used in non-standard ways.

EAD Element / attribute Calm field

archdesc @level fonds = collection
fonds = fonds

fonds = record group
series = class

series = series

file = file

item = item

archdesc @otherlevel sub-fonds = sub-fonds

sub-fonds = sub-group

sub-sub-fonds = sub-sub-fonds
sub-sub-sub-fonds = sub-sub-sub-fonds
sub-series = sub=series

sub-sub-series = sub-sub=series
sub-sub-sub-series = sub-sub-sub-series
bundle = bundle

origination Origination
origination Maker
origination CreatorName
unittitle Title
unitdate @normal Accumulation
unitdate Date

extent Extent
dimensions Dimensions
ormat Format
genreform Format
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genreform Object Name
physfacet Process Name
physfacet Process Method
physfacet Process Note
physfacet Colour
physfacet Material
repository Repository
unitid @label="former’ Alt_Ref_No
unitid Ref _No

+ @countrycode
+ @repositorycode

+ country_code
+ repository_code

language

Language

processinfo

Arch Note

note

Catalogue Status [Internal only]

accessrestrict

Access Status

phystech Physical Description
bioghist Admin History
scopecontent Description
arrangement Arrangement

controlaccess/corpname

Corporate Name

controlaccess/persname

Person Name

controlaccess/geogname

Place Name

controlaccess/famname

Person Name type=family

accessrestrict

Legal Status

accessrestrict

Access Conditions

accruals

Accruals

acqginfo

Acquisition
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altformavail Calm Copies
originalsloc Originals
appraisal Appraisal
custodhist Custodial History

userestrict

User Restrictions

userestrict

Use Restrictions

userestrict

Copyright

note

Accumulation Dates

relatedmaterial

Related Material

otherfindaid Finding Aids

note Notes

note Inscription Content
bibref Publn Note

dao @href url

daodesc URL Description

controlaccess/name

Creator Name

controlaccess/name Origination
controlaccess/name Maker
controlaccess/subject Subject
controlaccess/subject Term
controlaccess/subject Category
Level Level: Book
origination Creator Name
origination Origination
origination Author
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unittitle Title

unittitle Title Translation
origination Author
geogname Pub Place
publisher Cam Publisher
unitdate Pub Date

unitdate @normal

Accumulation

@countrycode +
@repository code

unitdate Date

unitdate @normal Pub Date

extent Extent

genreform Format
dimensions Dimensions
physfacet Physical Description
physfacet Binding Note
physfacet Inscription Content
physfacet Inscriber
repository Repository

unitid @label="former’ Alt_Ref_No

unitid + Ref _No

+ country_code
+ repository_code

language Language

note Catalogue Status [Internal]
phystech Condition

bioghist Admin History
scopecontent Description

scopecontent Abstract
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arrangement Arrangement
note Notes
note Publn Note

controlaccess/corpname

Corporate Name

controlaccess/persname

Person Name

controlaccess/geogname

Place Name

controlaccess/famname

Person Name type=Family

accessrestrict

Access Conditions

accessrestrict

Access Status

accruals Accruals

acqginfo Acquisition
acqginfo Acquisition Source
altformavail Copies
originalsloc Originals
appraisal Appraisal
custodhist Custodial History
custodhist Provenance

userestrict

User Restrictions

userestrict

Use Restrictions

userestrict

Copyright

note

Accumulation Dates

relatedmaterial

Related Material

otherfindaid Finding Aids
dao @href url

daodesc URL Description
odd Edition
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odd Series
odd ISBN
odd Class
odd Location

controlaccess/name

Creator Name

controlaccess/name Origination
controlaccess/name Author
controlaccess/name Editor
controlaccess/subject Subject
controlaccess/term Term
controlaccess/subject Category
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